Keysight Wireless Instruments

E7760B Wideband Transceiver
WARRANTY TERMS COVERING THE MATERIAL IN THIS DOCUMENT THAT CONFLICT WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT WILL CONTROL.

Technology Licenses

The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

U.S. Government Rights

The Software is "commercial computer software," as defined by Federal Acquisition Regulation ("FAR") 2.101. Pursuant to FAR 12.212 and 27.405-3 and Department of Defense FAR Supplement ("DFARS") 227.7202, the U.S. government acquires commercial computer software under the same terms by which the software is customarily provided to the public. Accordingly, Keysight provides the Software to U.S. government customers under its standard commercial license, which is embodied in its End User License Agreement (EULA), a copy of which can be found at http://www.keysight.com/find/sweula. The license set forth in the EULA represents the exclusive authority by which the U.S. government may use, modify, distribute, or disclose the Software. The EULA and the license set forth therein, does not require or permit, among other things, that Keysight: (1) Furnish technical information related to commercial computer software or commercial computer software documentation that is not customarily provided to the public; or (2) Relinquish to, or otherwise provide, the government rights in excess of these rights customarily provided to the public to use, modify, reproduce, release, perform, display, or disclose commercial computer software or commercial computer software documentation. No additional government requirements beyond those set forth in the EULA shall apply, except to the extent that those terms, rights, or licenses are explicitly required from all providers of commercial computer software pursuant to the FAR and the DFARS and are set forth specifically in writing elsewhere in the EULA. Keysight shall be under no obligation to update, revise or otherwise modify the Software. With respect to any technical data as defined by FAR 2.101, pursuant to FAR 12.211 and 27.404.2 and DFARS 227.7102, the U.S. government acquires no greater than Limited Rights as defined in FAR 27.401 or DFAR 227.7103-5 (c), as applicable in any technical data.

Safety Notices

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
Where to Find the Latest Information

Documentation is updated periodically. For the latest information about these products, including instrument software upgrades, application information, and product information, browse to one of the following URLs, according to the name of your product.

http://www.keysight.com/find/e7760b

To receive the latest updates by email, subscribe to Keysight Email Updates at the following URL:

http://www.keysight.com/find/MyKeysight

Information on preventing instrument damage can be found at:

www.keysight.com/find/PreventingInstrumentRepair

Contacting Keysight

For online assistance: http://www.keysight.com/find/assist

To contact Keysight Technologies: http://www.keysight.com/find/contactus

Is your product software up-to-date?

Periodically, Keysight releases software updates to fix known defects and incorporate product enhancements. To search for software updates for your product, go to the Keysight Technical Support website at:

http://www.keysight.com/find/techsupport
Table of Contents

Safety & Environmental Information 9
   Warning Statements and Symbols 10
   Safety 11
      Safety Compliance 11
      Acoustic statement (European Machinery Directive) 11
      General Safety Notices 11
   Cleaning 12
   Environmental Conditions (Operating) 12
      Environmental Stress Testing 12
   EMC (Electromagnetic Compatibility) 13
      South Korean Class A EMC declaration 13
      Declaration of Conformity 13
   Ventilation 14
   Location and Mounting 14
   Power requirements 15
      AC power cord 16
   Using Accessories 16
   Weight and Dimensions 17
   Protecting against electrostatic discharge 17

Quick Start 19
   Introduction 20
   Initial Inspection 22
      Shipping Problems? 23
      Input/Output Cables 23
   Instrument Location and Rack Mounting Requirements 24
      Locating the Test Set 24
      Table Top Ambient Temperature 24
      Rack Mounting: Hardware and Temperature 24
   Turning on the test set the first time 26
   Licensing 28
      Port Licenses 28
      Frequency Licenses 28
      Application Licenses 28
   Anti-virus Protection and Firewalls 29
Contents

Front and Rear Panel Functions 31
  Front Panel Features 32
  Rear Panel Features 34
  Front and Rear Panel Symbols 35

User Interface 37
  Screen Interface 38
    Screen Tabs 39
    System Settings 41
    Preset 42
    Meas Bar 43
    Menu Panel 44
    Measurement Display 45
    Control Bar 47
  Command Interface 48

Operating Tasks 51
  Alignments 52
    "All" Alignment 52
    Other Alignments 53
  Port Configuration 54
    Types of Ports 54
    Configuring Ports 55
    Port Rules (mmWave Ports) 56
    Port Rules (IFIO Ports) 57
  LAN Address Configuration 58
  Receiver Setup 59
  Source Setup 63

Test Set Operating System 67
  Keysight Software Installed 68
    Customer Installation of Software 68
  User Accounts 69
    Administrator login 69
    User login 69
    Customer creation of accounts 70
  Keysight Licensing Options 71
    Node-locked License 72
    Transportable License 72
    USB-Portable License 73
    Floating License 74
1 Safety & Environmental Information

The following topics can be found in this section:

“Warning Statements and Symbols” on page 10
“Safety” on page 11
“Environmental Conditions (Operating)” on page 12
“EMC (Electromagnetic Compatibility)” on page 13
“Ventilation” on page 14
“Location and Mounting” on page 14
“Power requirements” on page 15
“Using Accessories” on page 16
“Weight and Dimensions” on page 17
“Protecting against electrostatic discharge” on page 17
Warning Statements and Symbols

Caution and Warning notices are used in this document are described below.

**CAUTION**

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

**WARNING**

A WARNING denotes a hazard. It calls attention to an operating procedure, practice or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.

See also: “Front and Rear Panel Symbols” on page 35.
Safety

This product has been designed and tested in accordance with accepted industry standards, and has been supplied in a safe condition. The documentation contains information and warnings that must be followed by the user to ensure safe operation and to maintain the product in a safe condition.

Safety Compliance

This product complies with the essential requirements of the European Low Voltage Directive as well as current editions of the following standards (dates and editions are cited in the Declaration of Conformity):

- IEC/EN 61010-1
- Canada: CSA C22.2 No. 61010-1
- USA: UL std no. 61010-1

Acoustic statement (European Machinery Directive)

Acoustic noise emission
LpA <70 dB
Operator position
Normal operation mode per ISO 7779

General Safety Notices

**WARNING**
If this product is not used as specified, the protection provided by the equipment could be impaired. This product must be used in a normal condition (in which all means for protection are intact) only.

**WARNING**
No operator serviceable parts inside. Refer servicing to qualified personnel. To prevent electrical shock, do not remove covers.

**WARNING**
This is a Safety Protection Class I Product (provided with a protective earthing ground incorporated in the power cord). The mains plug shall only be inserted in a socket outlet provided with a protective earth contact. Any interruption of the protective conductor inside or outside of the product is likely to make the product dangerous. Intentional interruption is prohibited.
Safety & Environmental Information

Cleaning

**WARNING**
To prevent electrical shock, disconnect the Keysight Technologies Model E7760B from mains before cleaning. Use a dry cloth or one slightly dampened with water to clean the external case parts. Do not attempt to clean internally.

**WARNING**
Cleaning connectors with alcohol shall only be done with the instruments power cord removed, and in a well-ventilated area. Allow all residual alcohol moisture to evaporate and the fumes to dissipate prior to energizing the instrument.

Alcohol shall not be stored, or left open in the area of the equipment. Adequate ventilation shall be assured to prevent the combustion of fumes, or vapors.

Environmental Conditions (Operating)

This product is designed for use in the following conditions:
- For indoor use only
- Altitude up to 3000 m
- Temperature 5 to 40°C
- Type tested at 95% RH at +40°C (non-condensing)

**CAUTION**
This product is designed for use in Installation Category II and Pollution Degree 2 environment.

Environmental Stress Testing

Samples of this product have been type tested in accordance with the Keysight Environmental Test Manual and verified to be robust against the environmental stresses of Storage, Transportation and End-use; those stresses include but are not limited to temperature, humidity, shock, vibration, altitude and power line conditions.

Test Methods are aligned with IEC 60068-2 and levels are similar to MIL-PRF-28800F Class 3 (for Keysight GP, class 2 for OE).
EMC (Electromagnetic Compatibility)

This product complies with the essential requirements of the European Low Voltage Directive as well as current editions of the following standards (dates and editions are cited in the Declaration of Conformity):

- IEC/EN 61326-1
- CISPR Pub 11 Group 1, class A
- AS/NZS CISPR 11
- ICES/NMB-001
  This ISM device complies with Canadian ICES-001.
  Cet appareil ISM est conforme a la norme NMB-001 du Canada.

South Korean Class A EMC declaration

This equipment has been conformity assessed for use in business environments. In a residential environment this equipment may cause radio interference. This EMC statement applies to the equipment only for use in business environment.

<table>
<thead>
<tr>
<th>사용자 안내 문</th>
</tr>
</thead>
</table>
| 이기는 업무용 환경에서 사물환용으로 적합성평가를 받은 기기로서
  가정용 환경에서 사용하는 경우 전원공급의 우려가 있습니다 |

※ 사용자 안내문은 "업무용 방송통신기자재 에버적용"한다

Declaration of Conformity

The Declaration of Conformity for any Keysight product can be found on the website:
http://www.keysight.com/go/conformity
VENTILATION REQUIREMENTS: When installing the instrument(s) into a cabinet, consideration shall be given to the convection flow into and out of the cabinet. Consideration shall also be given to the individual instruments to avoid having the heated discharge of one instrument, now becoming the cooling intake air for another instrument.

Another area of concern is verification that the maximum ambient operating temperature of the instrument(s) is not exceeded by cabinet installation.

Keysight recommends forced air convection whenever an instrument(s) are installed in a cabinet and further recommends that the maximum operating temperature of the cabinet be reduced 10°C from the lowest of the maximum operating temperature of a single instrument.

If there are any concerns or special requirements an Keysight Field Engineer should be consulted to assure instrument(s) temperature compliance and performance.

Location and Mounting

Install the instrument so that the detachable power cord is readily identifiable and is easily reached by the operator.

The detachable power cord is the instrument disconnecting device. It disconnects the mains circuits from the mains supply before other parts of the instrument. (The front panel switch is only a standby switch and is not a LINE switch.)

Alternatively, an externally installed switch or circuit breaker (which is readily identifiable and is easily reached by the operator) may be used as a disconnecting device.

Consider ergonomics when locating any keyboard or mouse which will be used in connection with the instrument.
Power requirements

Line voltage does **not** need to be selected.

This test set does **not** contain customer serviceable fuses.

**WARNING**

This is a Safety Class 1 Product (provided with a protective earthing ground incorporated in the power cord). The mains plug shall only be inserted in a socket outlet provided with a protective earth contact. Any interruption of the protective conductor inside or outside of the product is likely to make the product dangerous. Intentional interruption is prohibited.

Failure to ground the test set properly can result in personal injury. Before turning on the test set, you must connect its protective earth terminals to the protective conductor of the main power cable. Insert the main power cable plug into a socket outlet that has a protective earth contact only. DO NOT defeat the earth-grounding protection by using an extension cable, power cable, or autotransformer without a protective ground conductor.

**WARNING**

The Mains wiring and connectors shall be compatible with the connector used in the premise electrical system. Failure to ensure adequate earth grounding by not using the correct components may cause product damage, and serious injury.

**CAUTION**

This instrument has autoranging line voltage input. Before switching on the instrument, be sure the supply voltage is within the specified range and voltage fluctuations do not exceed 10 percent of the nominal supply voltage.
AC power cord

The test set is equipped with a three-wire power cord, in accordance with international safety standards. This cable grounds the test set cabinet when connected to an appropriate power line outlet. Use the Keysight supplied power cord, or one with the same or better electrical rating. The cable appropriate to the original shipping location is included with the test set. See:

http://www.keysight.com/find/powercords

**CAUTION**

Always use the three-prong AC power cord supplied with this product. Failure to ensure adequate earth grounding by not using this cord can cause product damage.

This instrument has auto-ranging line voltage input; be sure the supply voltage is within the specified range and voltage fluctuations do not to exceed 10 percent of the nominal supply voltage:

- 100/120 VAC 50/60 Hz, 600 W MAX
- 220/240 VAC 50/60 Hz, 600 W MAX

**WARNING**

If this product is not used as specified, the protection provided by the equipment could be impaired. This product must be used in a normal condition (in which all means for protection are intact) only.

Install the instrument so that the detachable power cord is readily identifiable and easily reached by the operator. The detachable power cord is the instrument disconnecting device. It disconnects the mains circuits from the mains supply before other parts of the instrument. The front panel switch is only a standby switch and is not a LINE switch. Alternatively, an externally installed switch or circuit breaker (which is readily identifiable and is easily reached by the operator) may be used as a disconnecting device.

Using Accessories

For limitations on cable usage, see “Input/Output Cables” on page 23.
Weight and Dimensions

The weight and dimensions of the E7760B are as follows.

- Weight: 16.3 kg
- Height: 102 mm
- Width: 425 mm
- Depth: 555 mm

Protecting against electrostatic discharge

Electrostatic discharge (ESD) can damage or destroy electronic components (the possibility of unseen damage caused by ESD is present whenever components are transported, stored, or used).

Test equipment and ESD

To help reduce ESD damage that can occur while using test equipment:

**WARNING**

Do not use these first three techniques when working on circuitry with a voltage potential greater than 500 volts.

- Before connecting any coaxial cable to a test set connector for the first time each day, momentarily short the center and outer conductors of the cable together.
- Personnel should be grounded with a 1 MΩ resistor-isolated wrist-strap before touching the center pin of any connector and before removing any assembly from the test set.
- Be sure that all instruments are properly earth-grounded to prevent build-up of static charge.
- Perform work on all components or assemblies at a static-safe workstation.
- Keep static-generating materials at least one meter away from all components.
- Store or transport components in static-shielding containers.
- Always handle printed circuit board assemblies by the edges. This reduces the possibility of ESD damage to components and prevent contamination of exposed plating.

Additional information about ESD

For more information about ESD and how to prevent ESD damage, contact the Electrostatic Discharge Association (http://www.esda.org). The ESD standards developed by this agency are sanctioned by the American National Standards Institute (ANSI).
Safety & Environmental Information
Protecting against electrostatic discharge
2 Quick Start

This section describes how to set up your E7760B, install product licenses, and provide test set maintenance. You can also contact your Keysight representative to obtain on-site start-up assistance to help you with all steps outlined in this section, which is included with your E7760B purchase.

The following topics can be found in this section:

“Introduction” on page 20
“Initial Inspection” on page 22
“Instrument Location and Rack Mounting Requirements” on page 24
“Turning on the test set the first time” on page 26
“Licensing” on page 28
“Anti-virus Protection and Firewalls” on page 29
Introduction

The E7760B Wideband Transceiver is a test set which generates and measures high-frequency signals used in 5G testing.

The E7760B features two IFIO ports (6-18 GHz) and six mmWave ports (24-44 GHz). The mmWave ports are designed to connect with a test head, such as the M1740A mmWave Transceiver (~28 GHz); these test heads are purchased separately from the E7760B.

The photo below illustrates a common setup of the E7760B and its hardware accessories: the test set is connected to an M1740A mmWave transceiver, a monitor, a keyboard, and a mouse.

Figure 2-1 E7760B and accessories
Quick Start
Introduction

The diagram below shows one possible test scenario: the E7760B’s internal source provides (at output port A1) a stimulus signal to the Device Under Test (by way of the M1740A mmWave Transceiver, which up-converts the signal to the mm wave range fo the DUT).

A signal returned from the DUT is downconverted to the range of the E7760B, and provided to the E7760B at input port B1 for measurement.

Also, an IF output from the DUT is provided to the E7760B’s IFIO1 port for for measurement.

Figure 2-2  Use of mmWave ports and IFIO ports

Detailed information on how the E7760B is used in measurement applications is provided in the E7760B 5G User’s Guide.
Quick Start
Initial Inspection

Initial Inspection

Inspect the shipping container and the cushioning material for signs of stress. Retain undamaged shipping materials for future use, as you may wish to ship the test set to another location or to Keysight Technologies for service. Verify the contents of the container against the table below.

**WARNING**
Please consult ergonomic guidelines regarding placement of the external keyboard when using it with the instrument. Using the keyboard in an uncomfortable or awkward environment could result in personal injury.

<table>
<thead>
<tr>
<th>Item</th>
<th>Deliverable</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keysight E7760B Wideband Transceiver</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Getting Started Guide (this document)</td>
<td>Provides first-time power on instructions, licensing information, operating system information, and general hardware information.</td>
<td></td>
</tr>
<tr>
<td>Other product documents</td>
<td>These documents include:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Entitlement Certificate for VG NR Measurement Application (V9085EM0E)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Certificate of Calibration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– Recommended Due Date for Adjustment/Calibration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>– End User License Agreement</td>
<td></td>
</tr>
<tr>
<td>Power Cable</td>
<td>Connection for Instrument Power</td>
<td></td>
</tr>
<tr>
<td>Mini DisplayPort to DisplayPort adapter (B121-3225)</td>
<td>Enables you to view PC output on external display monitor</td>
<td></td>
</tr>
</tbody>
</table>
Quick Start

Initial Inspection

<table>
<thead>
<tr>
<th>Item</th>
<th>Deliverable</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rack Mount Flange Kit (1CM110A)</td>
<td>(Optional)</td>
<td>Includes two flange brackets.</td>
</tr>
<tr>
<td>Handle Kit (1CN106A)</td>
<td>(Optional)</td>
<td>Includes two handles.</td>
</tr>
</tbody>
</table>

NOTE

The E7760B is often used in conjunction with a mmWave Transceiver (a test head), but that is a separate purchase and is not always shipped with the E7760B.

Shipping Problems?

If the shipping materials are damaged or the contents of the container are incomplete:

– Contact the nearest Keysight Technologies office.
– Keep the shipping materials for the carrier’s inspection.
– If you must return a test set to Keysight Technologies, use the undamaged original or comparable shipping materials. See “Returning Your Test Set for Service” on page 112.

Input/Output Cables

Connecting the mmWave Ports to a mmWave Transceiver requires a special type of cable (the cable or cables needed are supplied with the transceiver). Other types of cables should not be connected to the mmWave Ports because they are not designed to carry the composite signal provided by those ports.

For the IFIO ports, standard commercially available RF cables may be used.
Instrument Location and Rack Mounting Requirements

Locating the Test Set

Make sure that the left-side panel fan inlet and right-side panel exhaust vent areas are not obstructed. The minimal required clearance is 2.75 inches (7 cm).

**NOTE**

Install the instrument so that the detachable power cord is readily identifiable and is easily reached by the operator. The detachable power cord is the instrument disconnecting device. It disconnects the mains circuits from the mains supply before other parts of the instrument. The front-panel switch is only a standby switch and does not act as a LINE switch. The rear-panel switch is a LINE switch, however it is only to be relied upon as supplementary protection. If needed, an externally installed switch or circuit breaker (which is readily identifiable and is easily reached by the operator) may be used as a disconnecting device.

Table Top Ambient Temperature

**CAUTION**

Do not exceed an ambient temperature of 45°C when operating the instrument on a table top.

Rack Mounting: Hardware and Temperature

If you choose to locate your test set in a rack, follow the guidelines provided in this section.

Based on the type of equipment rack you have, you must determine what rack rails you need. If you are using a Keysight System Test Rack, you can find information on what to order by referring to the Rack Mounting Flange Kit (Option E7515A-1CM) Installation Note.

**CAUTION**

When mounting instrument in a rack, do not exceed the level of:

- Outside rack ambient temperature of 35°C, or
- Internal rack air temperature of 45°C

Do not rack mount the test set side-by-side with any other instrument with side ventilation. Make sure the exhaust air from the first instrument is directed away from the inlet of the second unit. If the pre-heated air from the first instrument is directed into the second instrument, it can cause excessive operating temperatures in the second unit and can cause instrument failures. The test set draws air in from the left side and exhausts air from the right side. Do not mount other equipment immediately above the instrument. The minimal required clearance is 2.75 inches (7 cm).
VENTILATION REQUIREMENTS: When installing the instrument(s) into a
cabinet consideration shall be given to the convection flow into and out of the
cabinet. Consideration shall also be given to the individual instruments to avoid
having the heated discharge of one instrument, now becoming the cooling
intake air for another instrument.

Another area of concern is verification that the maximum ambient operating
temperature of the instrument(s) is not exceeded by cabinet installation.

Keysight recommends forced air convection whenever instruments are
installed in a cabinet and further recommends that the maximum operating
temperature of the cabinet be reduced 10°C from the lowest maximum
operating temperature of a single instrument.

If there are any concerns or special requirements a Keysight Field Engineer
should be consulted to assure instrument(s) temperature compliance and
performance.
## Turning on the test set the first time

### Table 2-1  First use of the test set

<table>
<thead>
<tr>
<th>Steps</th>
<th>Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  <strong>Connect a keyboard and mouse</strong></td>
<td>Connect the mouse and keyboard to two of the USB ports on the front panel of the test set.</td>
<td></td>
</tr>
<tr>
<td>2. Connect a monitor</td>
<td>Connect the monitor to the monitor port on the front panel of the test set.</td>
<td>Model E7760B has no display; an external monitor is required.</td>
</tr>
<tr>
<td>3. Connect any mmWave Transceivers which will be used with the E7760B.</td>
<td>Connect the RF cable (or cables) from the mmWave Transceiver (or Transceivers) to the desired mmWave port of the E7760B.</td>
<td>Such connections need to be made <strong>before</strong> powering up the E7760B; the test set will not recognize the connection if it is made after power-up.</td>
</tr>
<tr>
<td>4. Power on the test set</td>
<td>Position the test set so you have easy access to the power cord and plug it in. Press the front panel power switch to turn the test set on.</td>
<td>See “Instrument Location and Rack Mounting Requirements” on page 24 and “Power requirements” on page 15 for more details. The test set can require more than 5 minutes to power-on. This is affected by Windows start-up requirements. The Keysight Technologies screen appears.</td>
</tr>
<tr>
<td>5. Verify that the application opens</td>
<td>Wait for an instance of the V9060EM0E IQ Analyzer Measurement Application to appear on the monitor screen. The name of the measurement appears in the measurement tab at the upper left.</td>
<td></td>
</tr>
</tbody>
</table>
Quick Start
Turning on the test set the first time

Table 2-1 First use of the test set

<table>
<thead>
<tr>
<th>Steps</th>
<th>Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>6. Click on the measurement tab at the upper left to open the mode &amp; measurement screen; select 5G NR mode and the desired measurement, and click OK.</td>
<td>If the 5G NR application is not already installed, it will not be displayed under Mode. In that case, it will be necessary to install it, as described in the next step.</td>
<td></td>
</tr>
</tbody>
</table>

7. Install Y9085EM0E 5G NR Non-Signaling Waveform and Measurement Application, if it is not installed already (see the previous step). | The Y9085EM0E Entitlement Certificate includes instructions on how to redeem your license; download the application from Keysight Software Manager, and install the application on the E7760B. | |
Licensing

Some features of the test set are licensed features, and are unavailable if the appropriate license is not installed.

Licenses can be permanently tied to a particular instrument, or transferable from one instrument to another.

Licenses can also be perpetual or time-based (the latter have expiration dates).

See the e “Keysight Licensing Options” on page 71 for more information about license types.

Port Licenses

– License E7760B-RF2 is required to operate the IFIO ports.
– License E7760B-RF4 is required to operate the mmWave ports.

Frequency Licenses

– E7760B-FB1 (24.25 to 29.5 GHz; used in 5G testing with the M1740A mm Wave Transceiver)
– E7760B-FB5 (37 to 40 GHz; used in 5G testing with the M1740A mm Wave Transceiver)
– E7760B-FB6 (40 to 43.5 GHz; used in 5G testing with the M1740A mm Wave Transceiver)

Application Licenses

– License V9060EM0E: Test Set Measurement Application.
– License Y9085EM0E: 5G NR Non-Signaling Waveform and Measurement Application.
Anti-virus Protection and Firewalls

The instrument is shipped with the Windows 7.0 firewall enabled. Do not modify the default network settings as this may cause problems with the operating system of the test set.

No anti-virus software is shipped with the instrument. It is recommended that you install anti-virus software if your E7760B is connected to the LAN. Check with your IT department for recommendations.

**CAUTION**

Take care to verify that USB memory devices used with the E7760B are virus-free before using with the instrument.
Quick Start
Anti-virus Protection and Firewalls
3 Front and Rear Panel Functions

The following topics can be found in this section:

“Front Panel Features” on page 32
“Rear Panel Features” on page 34
“Front and Rear Panel Symbols” on page 35
Front Panel Features

Figure 3-1 E7760B Front Panel

The features are described in the table below.

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USB Connectors</td>
<td>The instrument provides six USB 2.0 Ports, Type A.</td>
</tr>
<tr>
<td>2</td>
<td>mmW Port LEDs</td>
<td>The LEDs are used to indicate port usage for the mmWave Ports. After the power-up self-test sequence (in which the LEDs are lit one at a time as they are checked) the LED for a particular port will be blue if it is being used as an output port (providing a stimulus to the DUT) or green if it is being used as an input port (measuring a signal received from the DUT). The LED for an inactive port is not lit.</td>
</tr>
</tbody>
</table>
| 3      | mmWave Ports (A1, A2, A3, B1, B2, B3); also includes 36 VDC supply and control signals | Type N connectors. These ports provide connection to a mmWave Transceiver, by means of a special RF cable which is provided with the transceiver. Do not connect or disconnect the RF cable, at these ports or at the mmWave Transceiver, while power is applied to the E7760B. Also note the label:  

**CAUTION**

36 VDC Output
Do not terminate or attenuate! For use with M1XXX mmWave Transceiver only

For port usage information, see “Port Rules (mmWave Ports)” on page 56. |
| 4      | Power On/Off                                    | Power Standby/On switch and indicator LEDs. A green light indicates power on. A yellow light indicates standby mode (AC power is supplied to the E7760B but power is not on).  
The AC power cord can be used as the system disconnecting device. It disconnects the main circuits from the main supply. |
Front and Rear Panel Functions
Front Panel Features

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>IF Port LEDs</td>
<td>The LEDs are used to indicate port usage for the IF Ports. The LED for a particular port will be blue if it is being used as an output port (providing a stimulus to the DUT) or green if it is being used as an input port (measuring a signal received from the DUT). The LED for an inactive port is not lit.</td>
</tr>
<tr>
<td>6</td>
<td>IF Ports (IFIO1, IFIO2)</td>
<td>Type SMA connectors. See “Port Rules (IFIO Ports)” on page 57. Note the label:</td>
</tr>
</tbody>
</table>
Rear Panel Features

Figure 3-2 E7760B Rear Panel

The features are described in the table below.

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Line Power</td>
<td>The AC Power Connection.</td>
</tr>
<tr>
<td>2</td>
<td>SYNC 1 &amp; 2</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>3</td>
<td>10 MHz IN, 10 MHz OUT</td>
<td>The 10 MHz IN BNC connector accepts a timebase reference input from an external source. Restrictions: do not remove an input to this connector without first switching the test set to internal mode; also, do not switch the test set to external mode without first applying an input to the connector. The 10 MHz OUT BNC provides a timebase reference output to external instruments.</td>
</tr>
<tr>
<td>4</td>
<td>LO CLOCK</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>5</td>
<td>LAN</td>
<td>An RJ45 connector for the TCP/IP Interface to a Local Area Network. This LAN port supports DHCP (dynamic assignment of IP address).</td>
</tr>
<tr>
<td>6</td>
<td>Monitor Port</td>
<td>This connector supports a connection to a monitor with a Mini DisplayPort.</td>
</tr>
<tr>
<td>7</td>
<td>USB</td>
<td>3 USB 2.0 ports, Type A.</td>
</tr>
<tr>
<td>8</td>
<td>TRIG 1, TRIG 2</td>
<td>BNC connectors. TRIG 1 receives an external trigger input to the receiver. TRIG 2 furnishes an internal trigger output from the source.</td>
</tr>
<tr>
<td>9</td>
<td>RESERVED</td>
<td>Reserved for future use.</td>
</tr>
</tbody>
</table>
Front and Rear Panel Symbols

Symbols used on the exterior of the test set are described below.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="ON symbol" /></td>
<td>This symbol is used to indicate power ON.</td>
</tr>
<tr>
<td><img src="image" alt="OFF symbol" /></td>
<td>This symbol is used to indicate power OFF.</td>
</tr>
<tr>
<td><img src="image" alt="STANDBY symbol" /></td>
<td>This symbol is used to indicate power STANDBY mode (yellow in standby, green when instrument is ON).</td>
</tr>
<tr>
<td><img src="image" alt="AC symbol" /></td>
<td>This symbol indicates the input power required is AC.</td>
</tr>
<tr>
<td><img src="image" alt="Ground symbol" /></td>
<td>This symbol indicates earth ground.</td>
</tr>
<tr>
<td><img src="image" alt="Instruction documentation symbol" /></td>
<td>The instruction documentation symbol. The product is marked with this symbol when it is necessary for the user to refer to instructions in the documentation.</td>
</tr>
<tr>
<td><img src="image" alt="CE mark" /></td>
<td>The CE mark is a registered trademark of the European Community.</td>
</tr>
<tr>
<td><img src="image" alt="Email address" /></td>
<td>The Keysight email address is required by EU directives applicable to our product.</td>
</tr>
<tr>
<td><img src="image" alt="RCM mark" /></td>
<td>The RCM mark is a registered trademark of the Australian Communications and Media Authority.</td>
</tr>
<tr>
<td><img src="image" alt="South Korean Certification (KC) mark" /></td>
<td>South Korean Certification (KC) mark; includes the marking’s identifier code which follows this format: MSIP-REM-YYY-ZZZZZZZZZZZZZZ</td>
</tr>
<tr>
<td><img src="image" alt="ICES / NMB-001" /></td>
<td>ICES / NMB-001 Cet appareil ISM est conforme a la norme NMB du Canada. This is a marking to indicate product compliance with the Industry Canadian Interference-Causing Equipment Standard (ICES-001). This is also a symbol of an Industrial Scientific and Medical Group 1 Class A product (CISPR 11, Clause 4).</td>
</tr>
<tr>
<td><img src="image" alt="CSA mark" /></td>
<td>The CSA mark is a registered trademark of the CSA International.</td>
</tr>
</tbody>
</table>
Front and Rear Panel Functions
Front and Rear Panel Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Symbol" /></td>
<td>This symbol indicates separate collection for electrical and electronic equipment mandated under EU law as of August 13, 2005. All electric and electronic equipment are required to be separated from normal waste for disposal (Reference WEEE Directive 2002/96/EC).</td>
</tr>
<tr>
<td><img src="image2" alt="Symbol" /></td>
<td>Indicates the time period during which no hazardous or toxic substance elements are expected to leak or deteriorate during normal use. Forty years is the expected useful life of the product.</td>
</tr>
<tr>
<td><img src="image3" alt="Symbol" /></td>
<td>This symbol indicates compliance with the China RoHS regulations for paper/fiberboard packaging.</td>
</tr>
</tbody>
</table>
4 User Interface

This is a basic introduction to the E7760B’s user interface.

For more detailed information, see the E7760B 5G User Guide, which is accessible from the Help menu.

The following topics can be found in this section:

- Screen Interface on page 38
- Command Interface on page 48
Screen Interface

The overall appearance of the display interface is illustrated below. Different parts of it are discussed in more detail in the following sections.

Figure 4-1  Application display interface (with results windows for Modulation Analysis)
User Interface
Screen Interface

Elements of the interface are discussed in more detail in the following sections.

**Figure 4-2** Elements of the display interface

**Screen Tabs**

These are used to select a measurement screen for viewing and configuration (to add another screen, click the + button at the right of the existing tabs).

**Figure 4-3** Screen tabs

Clicking on the currently selected tab brings up the **Mode/Meas/View** dialog, to change settings for that screen. (Measurements for 5G NR are found under the “5G NR” mode.)
Figure 4-4  Mode/Meas/View dialog

<table>
<thead>
<tr>
<th>Mode</th>
<th>Measurement</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>IQ Analyzer (Basic)</td>
<td>Channel Power</td>
<td>Normal</td>
</tr>
<tr>
<td>5G NR</td>
<td>Occupied BW</td>
<td>Carrier Info</td>
</tr>
<tr>
<td></td>
<td>ACP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SEM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Transmit On/Off Power</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PHvT</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Modulation Analysis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Power Stat CCDF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IQ Waveform</td>
<td></td>
</tr>
</tbody>
</table>

When Sequencing is On and there are multiple Screens, all Screens update in sequence. When Sequencing is Off, only the selected Screen updates.
System Settings

Clicking the "gear" icon opens the System Settings dialog, which allows you to access various information screens and settings interfaces. The tabs on the left side let you access various configuration screens.

Figure 4-5  System Settings

The System Settings screens include:

- System
- I/O
- User Interface
- Power On
- Restore Defaults
- Alignments
- Licensing
- Security
- Diagnostics
- Service
Preset

Clicking this icon opens a menu which provides access to the various ways in which settings can be restored to a default condition or a condition you defined earlier.

Figure 4-6 Preset
Meas Bar

This bar displays important settings for the measurement, in a series of annotation panels which can be clicked on to reveal menu choices for them. The panel at the far left, for example, allows you to toggle between continuous and single measurement modes, and also to restart or pause a measurement.

Figure 4-7  Meas Bar
Menu Panel

Clicking on the name at the top of the menu offers the available menus (Amplitude, BW, and so on) for selection. The selected menu is usually divided into separate sub-menus, any of which can be selected by clicking on the tabs to the right (for example, the tabs on the right of the Amplitude menu represent the Y Scale and Range sub-menus). Which items are included on a menu depend on which measurement is currently active, and sometimes on how other settings have been configured.

Figure 4-8 Menus (and sub-menus)
Measurement Display

The interface is centered around the display windows, which show the results of a measurement. The number of windows and the type of information displayed in them varies from measurement to measurement. For example, the Modulation Analysis measurement example below shows a constellation diagram, three graphical displays, and two tables of numerical data.

Figure 4-9  Measurement Display for OFDM
The Adjacent Channel Power measurement below is simpler, showing only one graph (for Gaussian noise distribution) and one table of numerical data.

Figure 4-10 Measurement Display for ACP
Control Bar

This provides controls and information displays related to various instrument functions that are independent of the current measurement.

Figure 4-11  Control Bar

- Windows
- File Functions
- Time/Date
- Block Diagram
- Undo/Redo
- Status Bar
- View Editor
- Full Screen
Command Interface

In addition to being controlled and monitored by way of the screen interface, the instrument can be controlled and monitored by means of SCPI commands. For example, averaging can be disabled for the ACP measurement screen by changing the **Averaging** setting to **On** in the **Meas Setup > Settings** menu. The same thing can be done by sending the command :

```
:SENSe:ACPower:AVERage: OFF.
```

**Figure 4-12** Screen interface setting vs. SCPI command

In the SCPI command syntax, variables are indicated by angled brackets; for example, a parameter specifying an amplitude in dBm might be represented in the command syntax by the variable `<ampl>`, but in an actual command this variable be replaced by an actual value, such as `-10`.

Where a command parameter must be one of a limited set of choices, the alternatives are listed, with vertical lines separating the choices: `OFF|ON|0|1`.

The SCPI syntax allows for certain elements of a command to be omitted for brevity. Where a command name is given in a mixture of upper-case and lower-case letters, the lower-case letters are optional (for example, `AVERage` can be shortened to `AVER`).

Also, any element that is enclosed in brackets is optional (although the brackets themselves are omitted if the enclosed element is included in the command). For example, `[ :SENSe ] :ACPower` can be shortened to `:SENS:ACP` (or simply `ACP`, as the `:SENSe:` element is entirely within brackets).
User Interface
Command Interface

The command which sets the measurement center frequency has the following syntax:

[:SENSe]:FREQuency:CENTer <freq>

This command can be sent in its long form:

:SENSe:FREQuency:CENTer 16 GHz

However, the same result is obtained by sending the command in its abbreviated form:

:FREQ:CENT 16 GHz

NOTE
There is not always a command equivalent for a function of the screen interface (some functions which relate only to the display do not need a command). Also, there is not always a screen interface equivalent for a command (some commands perform functions which aren't available from the screen interface).

Detailed information about the SCPI commands and how they are used is provided in the E7760B 5G User’s Guide and in the help file for the 5G application.
User Interface
Command Interface
5 Operating Tasks

The following topics can be found in this section:

“Alignments” on page 52
“Port Configuration” on page 54
“LAN Address Configuration” on page 58
“Receiver Setup” on page 59
“Source Setup” on page 63
Alignments

Alignments are internal calibration adjustments which the E7760B must make to ensure that internal signal levels are properly maintained. To avoid interruptions, the alignments are not run automatically, either at startup or afterward; you must run them explicitly.

"All" Alignment

This alignment of the source and analyzer in the E7760B is sufficient to maintain specified performance, provided that (1) the instrument’s internal temperature has not drifted more than 5° C since the previous alignment, and (2) no more than 24 hours have elapsed since the previous “All” alignment. The “All” alignment typically takes less than 5 minutes to run.

The alignment requires a 45-minute warm-up period after applying power.

To determine how long it has been (in seconds) since power-on, send the SCPI query:

```sql
:SYST:FORM:TIME?
```

To determine how long it has been (in seconds) since the previous alignment, send the SCPI query:

```sql
:CAL:TIME:LALL?
```

The instrument’s internal temperature (in °C) at the time of the last alignment can be checked by sending the SCPI query (the):

```sql
:CAL:TEMP:LALL?
```

The instrument’s current internal temperature (in °C) can be checked by sending the SCPI query (the):

```sql
:CAL:TEMP:CURR?
```

To run the alignment, select **System Settings > Alignments > Align Now All**, or send the SCPI command:

```sql
:CAL
```
Other Alignments

Three other types of alignments can be run, as described below.

**Cable Alignment**

To run the alignment, select *System Settings > Alignments > Align Cable*, or send the SCPI command:

```
:CAL:CABL
```

It is necessary to run this alignment again any time the mmWave Transceiver or the RF Cable Assembly is changed, or the RF Cable Assembly is moved from one port to another, or from one mmWave Transceiver to another. Before sending the command, attach the RF Cable Assembly from the mmWave Port port to the mmWave Transceiver. (This calibration is not applicable to the IFIO ports.)

**Source Alignment**

To run the alignment on the source only, select *System Settings > Alignments > Align Source*, or send the SCPI command:

```
:CAL:INT:SOUR
```

**Analyzer Alignment**

To run alignment on the analyzer (receiver) only, select *System > Run Alignments > Align Analyzer*, or send the SCPI command:

```
:CAL:INT:REC
```
Port Configuration

Types of Ports

The E7760B has two types of ports. The six mmWave Ports (A1–A3 and B1–B3) are used in conjunction with a mmWave Transceiver (M1740A, in the case of 5G testing), a test head which exchanges signals with a mmWave DUT through an Over-The-Air interface. The front-panel mmWave Ports do not actually send or receive mmWave signals; the mmWave Transceiver provides the necessary upconversion and downconversion to achieve the desired frequency range.

The other two ports are IFIO1 and IFIO2, which are used for lower-frequency IF signals exchanged directly with the DUT.

Figure 5-1  Port types: mmWave ports and IFIO ports
Configuring Ports

A given port can be configured as the output (source) port by selecting the port at **Input/Output > RF Source > RF Output Port**, or by sending the command:

```
```

The equivalent for the input (analyzer) port is:

**Input/Output > Input > RF Input Port**

```
```

Rules for port usage are described in the following sections.
Port Rules (mmWave Ports)

The mmWave Ports have the following usage requirements:

- An RF4 license is required to use the mmWave ports.
- The six mmWave Ports are divided into "A" and "B" banks (A1-A3 and B1-B3). Either bank can transmit or receive, but neither can do both at once. If "A" transmits, "B" receives, and vice versa.
- Each port within one of these banks is numerically paired with a port in the other bank. For example: if A2 is the Output Port, the Input Port must be B2 (not B1 or B3).
- It is not possible to perform a loop-back test by connecting an RF cable between any two of these ports. A loop-back test would require a mmWave Transceiver connected to one port on the "A" bank and another port on the "B" bank.
- In configuring the Input Port and Output Port settings, it is never possible to choose the same port (or bank of ports) for both at once. Use the "None" setting to avoid conflicts when configuring ports. For example, if you want to change the Input/Output > RF Source > RF Output Port setting to "mmW Port A1", and that is already the RF Input Port setting, set the Input/Output > Input > RF Input Port temporarily to "None" to avoid the setting conflict, and then set the RF Output Port setting to "mmW Port A1". The RF Input Port can then be given a different setting which does not conflict with the RF Output Port setting.
- It is not possible to set the Input/Output > RF Source > RF Output Port setting "None" while the source Output On setting is "True". Before setting the the RF Output Port setting to "None", set Input/Output > RF Source > RF Output to "Off", or send the command :OUTPut OFF.

Port connections to the M1740A mmWave Transceiver

When the E7760B is used with the M1740A mmWave Transceiver, port connections are always as follows:

- LO/Pwr/IF In on the M1740A is connected to one of the "A" mmW Ports of the E7760B (A1, A2, or A3).
- LO/IF Out on the M1740A is connected to one of the "B" mmW Ports of the E7760B (B1, B2, or B3).
- These cabling connections are not to be changed if a "B" mmW port is reconfigured as an output rather than an input; signal routing through the M1740A is automatically adjusted in such cases, to avoid the need for re-cabling.
Port Rules (IFIO Ports)

The IFIO ports (IFIO1 and IFIO2) have the following usage requirements:

- The RF2 license is required to use the RFIO ports.
- Neither of the two RFIO ports can transmit and receive at the same time. If IFIO1 is the Output Port, the Input Port must be IFIO2, and vice versa.
- In configuring the Input Port and Output Port settings, it is never possible to choose the same port for both at once. Use the "None" setting to avoid conflicts when configuring ports. For example, if you want to change the Input/Output > RF Source > RF Output Port setting to "IFIO1", and that is already the RF Input Port setting, set the Input/Output > Input > RF Input Port temporarily to "None" to avoid the setting conflict, and then set the RF Output Port setting to "IFIO1". The RF Input Port can then be given a different setting which does not conflict with the RF Output Port setting.
- It is not possible to set the the Input/Output > RF Source > RF Output Port setting to "None" while the source Output On setting is "True". Before setting the RF Output Port setting to "None", set Input/Output > RF Source > RF Output to "Off", or send the command :OUTPut OFF.
- The source frequency of the output port and the measurement frequency of the input port can be different.
- The IFIO ports differ from the mmWave ports in that it is possible to connect an RF cable between one and the other for loop-back testing.
LAN Address Configuration

The E7760B supports both dynamic and static assignment of its IP address, using the LAN port.

The LAN port is designed for dynamic IP addressing, using the Dynamic Host Configuration Protocol. If the your site network supports DHCP, the E7760B will be assigned an IP address automatically when it is connected to the LAN. Once the address is assigned, it is listed, along with the computer name, under System > Show System, as illustrated below. The address or computer name can be used to find the test set on the LAN.

Figure 5-2 LAN Address

Using the LAN port to connect the test set directly to the public LAN is potentially insecure, because the test set does not provide anti-virus protection. Connecting the test set to the public LAN by way of a PC with antivirus protection is the preferred solution.

To find the test set on the LAN, you will need to know its IP address or computer name. If you cannot easily obtain a monitor view of System > Show System, you can determine the computer name using the instrument serial number. The computer name is in the format A-E7760B-nnnnn, ending in the last five digits of the serial number.
Operating Tasks
Receiver Setup

Receiver Setup

The analyzer/receiver function of the E7760B relates to measurement of signals received from the DUT.

Clicking on the tab at the upper left corner of the display opens the Mode/Measurement/View selector, which you can use to select a particular kind of measurement. The 5G NR measurements are found under the 5G NR mode. In the example illustrated below, the Occupied Bandwidth measurement is selected by clicking Occupied BW and then clicking OK.

Figure 5-3 Selecting Mode/Measurement
Most measurement settings are made from the menus, which can be accessed by selecting the dropdown button near the upper right of the display.

**Figure 5-4  Accessing Menus**

Selecting a menu from the dropdown list displays the menu selections (usually the selections are indented under multiple tabs shown at the right).

**Figure 5-5  Measurement Menus**
Although some menu choices involve only a simple selection (On | Off) or a value to be entered (17 GHz), some choices cause a more elaborate selection screen to appear in the display. In the example illustrated below, Trigger > Trigger Settings Diagram opens an interactive display (the trigger source can be changed from Internal to Ext 1 by clicking on the graphic).

Figure 5-6 Settings Diagram
Another type of complex screen which some menu selections open is a configuration window such as the one illustrated below, which allow you to configure the **Carrier**, **Offset**, and **Limits** settings.

**Figure 5-7 Configuration Window**

The menu choices are different for each measurement. For more detailed information, see the E7760B 5G User’s Guide and in the help file for the 5G application.
Source Setup

The source function of the E7760B relates to generation of test signals to be transmitted to the DUT. (Not all measurement scenarios require these signals, but many do.)

Most source settings are made from the Input/Output > RF Source menu, illustrated below.

Figure 5-8 RF Source Menu

The menu choices here allow you to turn the RF Output on or off, to select the RF Output Port, to choose the Amplitude and Frequency for the generated signal, to turn Modulation on or off, and to open the ARB Setup window.
Operating Tasks
Source Setup

The **ARB Setup** window can be used to configure various functions of the arbitrary waveform generator.

**Figure 5-9**  
ARB Setup Window
Operating Tasks
Source Setup

Often the source will employ a user-defined waveform file for modulation (typically such a file would be created in Keysight Signal Studio software). To load a waveform file that is saved in a location on the disk drive, click the **File** icon at the bottom of the screen, and click the **Recall** icon which appears. This opens the **Recall** window; from there, select **Waveform** and **Recall From File**, and navigate to the appropriate file path to load the file.

**Figure 5-10  Recalling an ARB file**

For more detailed information about source setup, see the E7760B 5G User's Guide and in the help file for the 5G application.
Operating Tasks
Source Setup
6  Test Set Operating System

The following topics can be found in this section:

“Keysight Software Installed” on page 68
“User Accounts” on page 69
“Keysight Licensing Options” on page 71
“Licensing New Application Software - After Initial Purchase” on page 76
“Transporting a License Between Test Sets” on page 78
“Windows Configuration” on page 81
“Configuring Printers” on page 83
“Configuring the LAN” on page 84
“Windows Security” on page 85
“System Maintenance” on page 89
Keysight Software Installed

The E7760B has the 5G application (Y9085EM0E) already installed. Use of the application requires appropriate licenses. Whichever licenses were purchased with the instrument are installed at the factory (see “Licensing” on page 28). Other licenses can be purchased and installed later (including transportable licenses). For more information, see: http://www.keysight.com/find/E7760B

Customer Installation of Software

3rd Party software verified by Keysight

Keysight has verified that the following program is compatible with the test set applications: Symantec AntiVirus™ Corporate Edition version 10

Installation of other 3rd party software

The E7760B platform is an open Windows environment, so you can install non-approved software on the test set. However, installation of non-approved software may affect test set performance. Keysight does not warrant the performance of the test set with non-approved software installed.

Before installing any additional programs on the test set, you should exit the E7760B Application.

Also, you must not remove any applications or programs that are installed on the test set when it is shipped from the factory.

If you install programs other than those that Keysight has tested, it could cause problems with the test set's applications. If this happens, you should try uninstalling the program that has caused the problem, or try changing the program's configuration. If this does not correct the problem, you may have to use the Keysight Recovery system to reinstall the test set's system software.

Installation of additional or updated Keysight software

See “Instrument software installation” on page 95.
User Accounts

Administrator login

The Administrator account ships from the factory with the password “Keysight4u!”. Using the Administrator account you can perform the following operations:

- Install software
- Configure network and printer access
- Access all files on the test set
- Add or change user accounts and passwords
- Change Firewall settings
- Change Windows settings
- Change the time and date
- Run any application

User login

The default user account that ships from the factory is “Instrument” with the password “measure4u”. This user is a member of the Standard Users group. Using the Instrument account you can perform the following operations:

- Access files on the test set that are accessible to the Standard Users group
- Run applications that are accessible to the Standard Users group
Customer creation of accounts

You can create additional user accounts and decide on the level of security granted to any new user accounts created. For example, the level of security can be assigned as administrator, power user, user, backup operators. User names are not case sensitive but passwords are case sensitive.

NOTE

For the test set software to operate, the user account executing the software must be assigned Administrator or Power User privileges. Otherwise, the test set software will not operate correctly.

It is Keysight’s expectation that each user’s My Documents folder is mapped to the D: drive. This is to avoid overwriting the user’s data in the event the Keysight Recovery must be performed. Also, this facilitates convenient backup by copying the contents of the D: drive to external media. All users accounts created by the factory already have My Documents mapped to the D: drive. Please map all new users My Documents folders to the D: drive.
Keysight Licensing Options

Licenses can be tied to a particular instrument, or transferable from one instrument to another by various means.

Licenses can be either time-based or perpetual (the latter have no expiration date).

To verify which licenses are installed, open the Keysight License Manager from the Windows Start menu. (It can also be opened by clicking the "gear" icon at the upper left to open the System Settings screen, and clicking Licensing > License Manager.) The licenses installed on the test set are listed, with information provided about license types and expiration dates (in the illustrated example, "Fixed" indicates a node-locked license).

Figure 6-1  Installed licenses (as displayed in KLM 5.x)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Version</th>
<th>Expiration</th>
<th>Type</th>
<th>Count</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>V9060EM0E</td>
<td>V9060EM0E</td>
<td>2099.1231</td>
<td>None</td>
<td>Fixed</td>
<td>Unlimited</td>
<td>Local</td>
</tr>
<tr>
<td>E7760B-RF2</td>
<td>IF Testing</td>
<td>1.000</td>
<td>None</td>
<td>Fixed</td>
<td>Unlimited</td>
<td>Local</td>
</tr>
<tr>
<td>E7760B-RF4</td>
<td>mmWave OTA (independent VSA and VSG)</td>
<td>1.000</td>
<td>None</td>
<td>Fixed</td>
<td>Unlimited</td>
<td>Local</td>
</tr>
<tr>
<td>N7699A-D24</td>
<td>Measurement Applications Temporary License - demo only</td>
<td>2021/07/11</td>
<td>None</td>
<td>Fixed</td>
<td>Unlimited</td>
<td>Local</td>
</tr>
</tbody>
</table>

NOTE

Keysight License Manager, a tool which is used in managing and installing licenses, exists in two versions, which are used with different types of licenses; see “Keysight License Manager” on page 75 for more information.
Node-locked License

A node-locked license is a license which permits the licensed software to run on one particular machine. Each node-locked license is locked to an instrument or computer; the license is resident on the hard disk of the system it is locked to, and that system runs the licensed feature or product.

Trial licenses, which are sometimes provided by Keysight so that customers can try out a product, are node-locked, time-based licenses. Trial licenses are issued for a particular instrument or computer, and have an expiration date.

Transportable License

A transportable license is a type of node-locked license which is not tied permanently to a single instrument: it can be unlocked from one client host and then locked to another client host (however, it can only be assigned to one instrument at a time).

A transportable license is installed on an instrument by copying the contents of a license file into the Keysight License Manager application (KLM), either manually (copy and pasting file contents) or by placing the license files on a USB memory device (KLM automatically takes in any license files detected on the memory device). KLM can also be used to delete a license, or transport it to a different instrument.

Unlike permanently node-locked licenses, which are pre-installed at the factory with new instrument purchases, transportable licenses require redemption and installation of the license before the first use. This allows the user to determine on which instrument to initially install the application license.

Transportable licenses require a connection to the Keysight Software Manager (KSM) web site: https://ksm.software.keysight.com/ASM/External/

However, the connection to KSM is needed only for managing the check-in or check-out of the license. KSM also provides for storage of unused licenses which have been transported off instruments but are awaiting assignment to new instruments. The server will limit the number of transports per 30 day period per application license to 10.

Keysight recommends that instruments use the same instrument software release to ensure the latest code is available on each instrument, so that the user experience is identical between instruments. This is particularly important when transporting the license for a newly-released application which may only be available in the latest software release.
Test Set Operating System
Keysight Licensing Options

After initial installation of the license, when you want to transport a license, run Keysight License Manager on the host that currently has the license, and transport the license. (Select Help > Keysight License Manager Help and search for “transport” to find detailed instructions.)

**NOTE**

Transportable licenses for the E7760B allow you to transport licenses up to 30 times within 10 days.

Other related topics for managing your software and licenses can be found by reviewing the Keysight License Manager Help available by clicking "?” icon in the KLM window.

**USB-Portable License**

A USB portable license is another type of transferable license, in which the license is tied to a dongle which can be plugged into the instrument’s USB port.

A USB-portable license is a version of a transportable license, in which the license is locked to a USB dongle rather than to an instrument. An instrument that runs the licensed feature or product must have the license file resident on its disk drive, and have the dongle connected to one of its USB ports when it runs the licensed feature or product. Transporting the license, in this case, becomes a simple matter of plugging the USB device into a different instrument.
Floating License

A floating license (sometimes referred to as a network license) is another type of transferable license, in which the license is assigned temporarily by a designated license server. Setup your license server by installing Keysight License Manager 6.

Floating licenses reside on the license server and are checked out for use by Keysight products (instruments or applications), then returned (checked in), when no longer needed, so that they can be used on another computer or instrument.

Floating licenses can also be borrowed for a specified number of days. Once you have borrowed a license, you can disconnect the licensed instrument or computer from the license server and continue to use the license offline for the duration of the borrow period.

Figure 6-2  Floating license installation process

NOTE

The Keysight implementation of FlexNet Publisher floating licensing requires the FlexNet Publisher license server manager (lmgrd) and Keysight vendor daemon (agileesofd) to run on any local computer used as a license server system.
Keysight License Manager

Keysight License Manager exists in two forms. KLM 5.x (revision 5.3 or later) is used for node-locked and transportable licenses.

KLM 6 is used for floating and USB-portable licenses.

**NOTE**

KLM 5.x should not be regarded as an outdated version of KLM 6. These are separate tools, used for different types of licenses. Do not remove KLM 5.x on the assumption that KLM 6 makes it obsolete.

These two versions of Keysight License Manager are not difficult to distinguish. The KLM 6 window looks very different from KLM 5.x, and shows "Keysight License Manager 6" at the upper left of the window frame.

**Figure 6-3**

Different versions of Keysight License Manager
Licensing New Application Software - After Initial Purchase

Additional measurement application software can be ordered after your initial purchase of the E7760B test set. Software upgrades are provided in a kit that includes an option based Entitlement Certificate. The licenses are downloaded from the license Web site onto a storage device so they can be loaded into the instrument.

If you do not want to wait for your upgrade kit to arrive, licenses can be installed using any available USB storage device. If you choose to do this, we recommend that the latest version of the instrument software be installed. This ensures that the measurement application being licensed and installed matches the most current version of the instrument software.

The latest revision of the software may be downloaded from:
http://www.keysight.com/find/E7760B

A license key is usually for one instrument model and serial number combination. The license key will only install itself on that instrument.

No calibration is required after a test set application installation.

The installation procedure is as follows:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Redeem the Option Upgrade Entitlement Certificate</td>
<td>Follow the instructions on the certificate.</td>
<td>Log into MyKeysight at <a href="http://www.keysight.com/my">http://www.keysight.com/my</a> and go to the Keysight Software Manager to redeem your entitlement certificate. After redeeming your Option Upgrade Entitlement Certificate you will receive an e-mail with a License Certificate (.lic file).</td>
</tr>
<tr>
<td>2. Save the license file</td>
<td>Save the .lic file to the root directory of a USB storage device.</td>
<td></td>
</tr>
<tr>
<td>3. Load the license file</td>
<td>Connect the USB storage device to one of the test set USB ports.</td>
<td>Windows will detect the new hardware and may display the configuration menu. The test set automatically loads the license file. (This may take a few minutes) Upon completion, the Keysight License Manager displays a “Successful License Installation” message.</td>
</tr>
</tbody>
</table>

NOTE

Alternatively the license file can be manually installed over USB or LAN by placing the license file in the following folder on the test set:
C:\Program Files\Agilent\licensing
### Test Set Operating System

**Licensing New Application Software - After Initial Purchase**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td><strong>Verify installation</strong></td>
<td>The test set automatically loads the license file. (This may take a few minutes). Upon completion, the Keysight License Manager displays a “Successful License Installation” message. &lt;br&gt;On the License tab of the System &gt; System Information window, verify that the new license is listed.</td>
</tr>
<tr>
<td>5.</td>
<td><strong>Restart the E7760B Application</strong></td>
<td>Close the E7760B Application and re-launch it, to activate the new license.</td>
</tr>
</tbody>
</table>
Transporting a License Between Test Sets

Transportable licenses are identified as such in the **Type** column of Keysight License Manager.

To transport a license from one test set to another, Keysight recommends that both test sets be at the same instrument software release. This ensures that the user experience is identical between instruments.

As a minimum, the instrument software release in the test set that will receive the transportable license (the "target instrument") must at least be able to support the desired application.

The E7760B supports several ways of transporting licenses. The procedure below will focus on the most common procedure, where neither of the test sets has access to an internet connection. For this procedure to work, a PC with an internet connection is required.

You will need the following:

- USB flash drive
- USB keyboard
- USB mouse

We will refer to the test set from which the transportable license will be removed as the "source instrument". We will refer to the test set which will receive the transportable license as the "target instrument".

The installation procedure is as follows:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Connect the USB devices to the source instrument</td>
<td>Connect the USB flash drive, USB keyboard, and USB mouse to the USB ports on the source instrument.</td>
<td>It will be necessary to use one or more of the rear panel ports to connect the USB devices.</td>
</tr>
<tr>
<td>2. Verify software version in each test set</td>
<td>For each test set, select <strong>System &gt; System Information &gt; System</strong> and make note of the Instrument S/W Revision on each.</td>
<td>Ideally, the revisions will be the same. But at least, both versions should be able to support the application whose license is being transported.</td>
</tr>
<tr>
<td>3. Obtain the Host ID from the Target Instrument</td>
<td>On the target instrument, select <strong>System &gt; System Information &gt; System</strong> and make note of the Host ID.</td>
<td>This information will be needed to issue the license for the target instrument. The Host ID is the model number, followed by a comma, followed by the serial number.</td>
</tr>
</tbody>
</table>
### Getting Started Guide

**Test Set Operating System**

**Transporting a License Between Test Sets**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>4. Start the License Manager on the Source Instrument</strong></td>
<td>Using the Windows Start menu on the source instrument, open Keysight License Manager. It may take a minute for the Keysight License Manager screen to be fully populated with all the installed licenses:</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Version</th>
<th>Expiration</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y905EEMOE</td>
<td>Y905EEMOE</td>
<td>2099.1231</td>
<td>None</td>
<td>Fixed</td>
</tr>
<tr>
<td>E7750B-RF2</td>
<td>IF Testing</td>
<td>1.000</td>
<td>None</td>
<td>Fixed</td>
</tr>
<tr>
<td>E7750B-RF4</td>
<td>mmWave OTA (independent: VSA and VSG)</td>
<td>1.000</td>
<td>None</td>
<td>Fixed</td>
</tr>
<tr>
<td>N7699A-D24</td>
<td>Measurement Applications Temporary License - demo only</td>
<td>1.000</td>
<td>2021/07/11</td>
<td>Fixed</td>
</tr>
<tr>
<td>V9050EEMOE</td>
<td>V9050EEMOE</td>
<td>2099.1231</td>
<td>None</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

| **5. Transport the Transportable License from Source Instrument** | Follow these steps: | Be sure you are selecting a transportable license and not a node-locked (perpetual) license. Although you are "deleting" the transportable license, the ultimate action will be to transport it. The information in this dialog box will be used to issue a new license for the target instrument. |
| 1. On the source instrument, locate the desired license to be transported in the KLM window and click on it to highlight it. Its option designator should include the letters "TP" or "TY". |  |
| 2. Right-click on the mouse and select Delete. |  |
| 3. Click Yes in the License Deletion Confirmation dialog box. |  |
| 4. After a few seconds, a Transport License dialog box will appear. Click OK and save the *.url file on the USB flash drive, with a name such as "5G_license.url" |  |

| **6. Get New License from KSM Transportation Web page** | Follow these steps: | The PC must have an internet connection and an available USB port. Most of the fields have been populated from the information in the *.url file. Be very careful when entering the New Host ID. A mistake made in entering the New Host ID will result in an invalid license being issued. Be sure there is a comma between the model number and serial number. There should be no spaces in the Host ID. |
| 1. Insert USB flash drive into PC that is connected to the internet. |  |
| 2. On the PC, locate the *.url file on the USB flash drive that was saved in the previous step and click on it. |  |
| 3. After a few seconds, the KSM Transportation Web page will appear. One field, the New Host ID, will be empty. |  |
| 4. Enter the Host ID of the target instrument (step 3 above) into the field marked New Host ID. |  |
| 5. Click Submit. |  |
### Transporting a License Between Test Sets

**7. Save License File to USB Flash Drive**

**Follow these steps:**

1. The KSM Transportation Web page will indicate that a license file is available and display two links to the license file. Right-click on the license file and select Save Target As...

2. Save the license file to the root level of the USB flash drive, keeping the ".lic" file extension.

3. Close the Save dialog and exit the KSM Transportation Web page.

**Notes:**

Either link can be used to either display or save the license file.

The license file must be saved to the root level of the USB flash drive for it to be recognized by the target instrument.

---

### Install License File in Target Instrument

**Follow these steps:**

1. With the target instrument running, insert the USB flash drive into one of the front panel USB ports. After a few minutes, you should see a message saying "Successful License Installation".

2. Cycle power on the target instrument.

3. Once the test set has re-booted, the application should be ready to use on the target instrument.

**Notes:**

The Keysight License Services running on the target instrument looks for *.lic files whenever it detects a USB device has been inserted. If the contents of the *.lic file are appropriate for the instrument, the license will be installed automatically.

Newly-installed licenses are only recognized by the instrument software on power-up.
Windows Configuration

The Windows settings have been optimized for the best measurement performance. Any modifications to these settings may degrade test set performance and measurement speed. In general, most Windows System settings (typically set through the Windows Control Panel) should not be modified. Those that can be safely modified are listed below.

**CAUTION**

To recover from problems caused by changing Windows systems settings, you may have to reinstall the Windows system and test set application using the Keysight Recovery process.

### Settings that can be changed

You may change the following Windows settings or administrative tasks (available from the Windows Control Panel) to select your personal preferences.

Before changing any Windows System settings, exit the test set application.

<table>
<thead>
<tr>
<th>You may use this feature</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Windows Update" /></td>
<td>Configure Microsoft Windows Automatic Updates.</td>
</tr>
<tr>
<td><img src="image" alt="Action Center" /></td>
<td>Install and configure an Anti Virus program.</td>
</tr>
<tr>
<td><img src="image" alt="User Accounts" /></td>
<td>Set up new test set user accounts. Do not delete or modify the “KeysightOnly” or “AgilentOnly” user account.</td>
</tr>
<tr>
<td><img src="image" alt="Network and Sharing Center" /></td>
<td>Add the test set to a network.</td>
</tr>
<tr>
<td><img src="image" alt="Devices and Printers" /></td>
<td>Install and configure a printer.</td>
</tr>
<tr>
<td><img src="image" alt="Date and Time" /></td>
<td>Set the time and date.</td>
</tr>
</tbody>
</table>
### Settings that must not be changed

Avoid changing any settings in this section. Changes to the following settings may degrade test set performance, screen displays, and measurement speed.

<table>
<thead>
<tr>
<th>Do NOT use this feature</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Options</strong></td>
<td>Do not change Power Options.</td>
</tr>
</tbody>
</table>
| **System**              | Do not modify System Properties, Hardware Tab settings.  
                          | Do not modify System Properties, Advanced Tab settings (except as recommended under “Settings that can be changed” above). |
| **Fonts**               | Do not remove installed Fonts. |
| **Display**             | Do not change the following Display Settings:  
                          |  — Screen Saver settings (under “Personalization”)  
                          |  — Screen resolution, 1024 x 768 (under “Adjust Resolution”)  
                          |  — DPI setting (under “Set custom text size”) |
| **Region and Language** | Do not change any settings under “Region and Language” or the instrument keyboard and display may not operate properly |
| **User Accounts**       | Do not delete or modify the “KeysightOnly” user account. |

In addition, **DO NOT**:  
- Add, delete, or modify hard-disk drive partitions.  
- Delete or modify Keysight or Agilent registry entries.  
- Change the contents of any directories containing the name "Keysight".  
- Stop these services:  
  - The MSSQL$CDF service or uninstall the “Microsoft SQL Server Desktop Engine”  
  - The IIS server or tamper with any virtual directories (or their contents) that came configured with the test set.  
- Uninstall these libraries, interfaces, or programs:  
  - The Agilent/Keysight I/O Libraries  
  - The .NET Framework or any Hotfixes or Service Packs for the .NET Framework  
  - The “Microsoft Visual J# .NET Redistributable Package 1.1”  
  - Programs that begin with "Keysight"  
  - The Adobe Acrobat Reader  

Modify the Keysight I/O Library “GPIB27”, “GPIB28” interfaces shown as configured Instrument I/O in the Keysight Connection Expert or I/O Config
Configuring Printers

To open the printer configuration window, select **File > Print**, or click the printer icon in the toolbar. This setup process is most easily done using a USB mouse and an external keyboard.

When setting up a new printer, you may need to load the printer driver (unless you are using a network printer that your IT department has set up to include the driver). The manufacturer of the printer supplies the driver software and process. That may require that you attach an external USB disk drive. An alternative is to connect the test set to the LAN and download the driver from the printer manufacturer’s internet site.

Figure 6-4 Print window
Configuring the LAN

Hostname

The Computer Name, or hostname, is pre-configured from the factory. It must be a unique name so that it does not conflict with other equipment on your LAN. The pre-configured Computer Name is K-E7760B-xxxxx, where xxxx represents the last 5 digits of the test set serial number.

To change the Computer Name consult the Microsoft Windows Help and Support Center.

IP Address & Gateway

The test set is pre-configured to obtain an IP Address using DHCP. The IP Address and Gateway can be changed. Consult the Microsoft Windows Help and Support Center to configure the LAN.
Windows Security

Microsoft recommends the following to ensure the test set Windows operating system is protected:

– Use an internet firewall.
– Get the latest critical Windows updates.
– Use up-to-date antivirus software.

To check the status or make changes in the security settings for your test set, click **Start**, **Control Panel**, and then **System and Security**. The following window appears:

The window may look slightly different on your test set.
Windows Firewall

Click **Windows Firewall** in the System and Security window to check the firewall status of your test set. The test set is shipped with the Windows Firewall enabled.

The window may look slightly different on your test set.

Windows Firewall exceptions for programs and ports have been added to allow proper operation of the test set over a network. Modifying these settings may prevent the test set from operating properly.
Automatic updates

The default test set setting is to never check for critical Windows Updates and notify you, if the test set has internet access.

You can change the configuration of the Microsoft Automatic Updates. Under Windows Update in the System and Security window, click Turn automatic updating on or off to change settings. Under Important Updates, you can choose a method from the dropdown selector; the recommended setting is Check for updates but let me choose whether to download and install them. Click the checkbox under Recommended Updates, so that it matches the update method for Important Updates. If you choose not have any kind of automatic checking, you can manually update windows at any time by clicking Windows Update > Check for updates on the System and Security window.

Keysight recommends making Windows updates as they become available. However, be aware that downloading and installing Windows Updates can be network and CPU usage intensive (impacting the test set performance), and some Windows Updates automatically reboot the test set. Therefore, it is best to perform Windows Updates only when the test set is not in normal use.
Virus protection

Under Action Center in the System and Security window, click Review your computer’s status and resolve issues to check the status of virus protection on your test set. There is no antivirus software included with your test set. Antivirus application software has been tested to be compatible with the test set. See the section on “3rd Party software verified by Keysight” on page 68 for anti-virus software that has been tested by Keysight.

Having antivirus software installed may have a slight impact on the test set performance.

Spyware protection

The Review your computer’s status and resolve issues window described above also shows the status of spyware protection. There is no anti-spyware software installed on the test set. This should not be a problem if you do not use the test set for a lot of internet browsing. Having spyware in the test set could have an impact on the test set performance.
System Maintenance

Back-up

It is recommended that you have a regular back-up strategy for all files which you create (these will be on the D: drive). Your IT department may already have a back-up strategy in place which is suitable for the test set and its data.

The Windows operating system has a Backup utility that you can use to archive files and folders in case of a hard disk drive failure. See the Microsoft Windows Help and Support Center for more information on this utility.

When performing back-ups, we recommend that you back-up the data to an external storage device connected to your company's internal network or one of the test set’s USB connectors. Also, you should perform back-ups at times when the Server PC is not being used for normal operations as it may impact the test set’s overall performance.

System Restore

The Windows operating system has the capability to restore the system to a previous point in time. System Restore is enabled with default settings as provided by Microsoft. However, System Restore is not 100% successful. Therefore, it is not the recommended method to back-up the instrument. System Restore has not been tested to verify successful restoration on this instrument.

Disk defragmenting

Over time the hard disk on the test set becomes fragmented. Windows has a Disk Defragmenter utility that you can use to defragment the hard disk. See the Microsoft Windows Help and Support Center for more information on this utility.

**NOTE**

Running Disk Defragmenter should be done when the measurement application is not running. Measurement throughput is significantly impacted while disk defragmentation is in process.
USB Connections

The instrument provides USB 2.0 ports on the front panel and rear panel (see “Front Panel Features” on page 32 and “Rear Panel Features” on page 34). These can be connected to USB mass storage devices and to accessories such as printers and keyboards. The test set USB Host support includes the standard Microsoft Windows USB class drivers for human interface, mass storage, printing, scanning, and imaging devices.

In addition, the Keysight IO Libraries software that was included with your test set contains USB Host drivers that allow control of other test sets connected to the USB bus.

Keysight Technologies does not support or warrant correct test set operation if additional USB drivers from third parties are installed in the test set. It is possible that additional drivers could break the normal USB operation. If USB operation is broken, recovery might require reinstalling the test set application using the hard drive recovery process.

Hard Drive Partitioning and Use

The drive is partitioned into 3 sections: C:\, D:\, and E:\

- The C:\ partition contains the Windows operating system and software installed by Keysight. This is an Open System which means you can install additional software. However, only a limited set of software applications are tested for use with the Keysight measurement software. The installation and/or use of other software is not warranted and could interfere with the operation of the measurement software. If instrument repair is ever needed, the Keysight version of the C:\ drive is the only part of the instrument software that is restored by the Instrument Image Recovery System. You must reload any other software that you have added in the instrument.

- The D:\ partition is reserved for data storage. The User Accounts that are configured by Keysight have their Users folder mapped to the D:\ drive. This is for the convenience of backing-up the test set measurement data. You should always back-up the data on the D:\ drive to an external device. This enables you to restore the data should the hard drive need to be replaced.

- The E:\ partition is reserved for Keysight’s use. The primary use of the E:\ drive is for storing the Calibration and Alignment data. Do not change or overwrite the files on this drive. This could cause your instrument to not meet specifications, or even to stop functioning correctly. Do not use this drive for data storage.
Hard Drive Recovery Process

The Keysight Recovery System can be used to repair errors on the test set's C: drive partition, or to restore the original factory configuration of the system software. The Keysight Recovery System is stored in a separate hidden hard disk drive partition.

Repairing errors on the hard disk drive may result in loss of data or files. If you need more information about the Windows “chkdsk” error repair process, see the chkdsk documentation in the Microsoft Windows Help and Support Center.

Restoring the original factory system software does not restore any of the following items:

- Windows system configurations that were made after the test set was shipped from the factory. For example, Windows and Service Pack updates, user accounts, and Windows configuration settings. After an Keysight Recovery, these configurations need to be redone.
- Additional software that was installed after the test set was shipped from the factory. After an Keysight Recovery, that software needs to be re-installed.
- Any data or programs saved on the D: or E: drives.
- Any upgrades that were made to the Keysight measurement application software.

Restoring the original factory system software will not synchronize the code in the Field Programmable Gate Arrays (FPGAs) on the various hardware assemblies. As a result, you may see an error dialog box appear during the final boot-up at the end of the recovery process. This typically occurs when there are significant differences between the software version installed prior to performing the recovery and the version restored by the recovery. In these situations, upgrade the software to the latest version.

NOTE

It is recommended that you use a regular back up strategy. Your IT department may already have a back up strategy in place which is suitable for the test set and its data. See “Hard Drive Partitioning and Use” on page 90. Using the Keysight Recovery System in conjunction with a regular back up strategy should allow you to fully recover the test set software and data.

It is recommended that routine backups of the test set information be performed to keep current archives of the test set information. This allows a full recovery of the test set information after the test set recovery system operations are performed. See “Hard Drive Partitioning and Use” on page 90 for more details.
<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Make sure the test set is turned off.</td>
<td>After the Keysight Technologies screen is displayed, the Windows Boot Manager screen is displayed for five seconds.</td>
</tr>
</tbody>
</table>
| 2. Turn test set power on. | Follow these steps:  
1. Press 2, then press Enter to select the recovery.  
2. Press 1, then press Enter to continue.  
3. Press 1, then Enter to confirm. |
| 3. When the Keysight Recovery System has booted, follow the on-screen instructions to recover the image of the C: drive. | After exiting the Keysight Recovery System, the test set reboots. If the original factory test set system has been restored, the test set re-executes the process described in “Turning on the test set the first time” on page 26. |
| 4. Wait for the reboot | Additional recovery steps may be required to fully recover the system to a more current working state. This could involve restoring your own backups of the test set configuration, including re-installing applications, data, and performing system customizations. |
Updating the software

The purpose of this update is to ensure that the E7760B’s software, its measurement mode applications, and the FPGA content of its PC boards are all current and up to date.

An update to the instrument software revision does not require a new license key for the measurement applications, so long as the applications were licensed prior to the update.

This procedure will only update the instrument software that currently resides on the C: drive of the instrument. It will not update the version that exists on the recovery partition. Because of this, if the recovery process is performed, the instrument will revert back to the instrument software revision that was originally shipped from the factory.

Determining the current software revision

To determine what revision of instrument software is currently installed, select System > System Information. One the window which opens, look for the "Instrument S/W Revision" entry on the "System" tab. If the installed revision is the same as the latest revision on the web, there is no need to update the instrument software.

Requirements

The following requirements must be met to use this procedure:

– The E7760B must be functioning properly before the update is attempted.
– You must have a USB keyboard and mouse.
– You must be able to log in to the instrument as the administrator.
– You must be able to transfer a large file (~.6 MByte) to the E7760B being updated.

File Download


2. Download the executable file by clicking on the file link. Save the file to a location of your choice. If you do not have the ability to download files directly to the C: drive of the E7760B being updated, store the file on a large capacity USB storage device for transfer to the instrument. (The file size is ~.6 MByte.)
User account and log-in
The default user account is Instrument, which does not have the required permissions to install the instrument software updates. For the process outlined below, the user must be logged in as Administrator.

The automated instrument software upgrade process has an install wizard which removes the old software version and installs new software version without manual steps. The removal of the old software version and the installation of the new software version completes in approximately 15 minutes.

1. Connect a USB keyboard and mouse to the E7760B.
2. If the E7760B is not already running, power it up and allow it to boot up completely.
3. Close the E7760B measurement application if it is running. Right-click in the application window, and select elect Utility > File from the right-click menu; select the Exit softkey and click OK in the confirmation window.
4. Log out as the default user (Instrument). Click the Start icon at the lower left corner of the screen, and select Log Off.
5. Select the Administrator icon on the Windows desktop, to log in as follows:
   User Name: administrator
   Password: Keysight4u!
6. If a “Found New Hardware” wizard window pops up, select “No, not at this time” to bypass the activity.
Instrument software installation

If you downloaded the instrument software update file to the instrument via LAN, access that file from the location that it was stored and proceed to step 1.

If you downloaded the instrument software update file to a USB storage device, plug that into one of the USB ports on the front of the instrument. Access the file for the removable drive, then proceed to step 1.

**CAUTION**

This installation may involve updating of FPGA devices within the E7760B. During the installation, DO NOT power off the E7760B for ANY reason! Interrupting the FPGA update process can place the instrument in an unusable state, requiring it to be returned to Keysight for repair.

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Double-click on the installer file, and click “Yes” in the confirmation window that appears.</td>
<td>The installer is an executable file with a name in the format: E7760B_Installer_A.xx.xx_Self-Extractor.exe</td>
</tr>
<tr>
<td>2. A window appears showing the extraction of the software installer.</td>
<td>A confirmation window will ask for your permission to continue the installation process after the installer has been extracted.</td>
</tr>
</tbody>
</table>
### Step 3
Wait while the previous version of the software is uninstalled.

![Image of software uninstallation](image)

### Step 4
Wait while the new version of the software is installed.

During installation, you might see additional windows showing that FPGA changes are being made. (However, not all software updates involve such changes.)

![Image of software installation](image)
<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.</td>
<td>After installation is completed, a power shutdown is required. Click the Finish button when you are ready to reboot.</td>
</tr>
</tbody>
</table>

![Image of software installer](image.jpg)

6. Reboot manually if necessary.

If the instrument shuts down but does not reboot automatically, remove the USB storage device and cycle power. The boot order for the instrument may have been changed in the instrument BIOS previously, and the instrument may be instructed to boot from USB first, and the internal drive second. If this is the case, failure to remove the USB device will result in an error, as the instrument attempts to boot from it.

7. Verify that the new software is installed.

Select System > System Information. On the window which opens, look for the “Instrument S/W Revision” entry on the "System" tab, and verify it matches the revision of the installer.

**NOTE**

Additional recovery steps may be required to fully recover the system to a more current working state. This could involve restoring your own backups of the instrument configuration, including re-installing applications, data, and performing system customizations.
### Configuring recovery prompt timing

You can configure the time at which the test set power-up process waits for the selection of the recovery process by performing the following steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. From the Windows Start menu, right-click Computer and click Properties.</td>
<td>This opens the System window.</td>
</tr>
<tr>
<td>2. Click Advanced System Settings in the left pane.</td>
<td>This opens the System Properties window.</td>
</tr>
<tr>
<td>3. In the Startup and Recovery section, click Settings.</td>
<td>This opens the Startup and Recovery window.</td>
</tr>
<tr>
<td>4. Under the System Startup section, uncheck the &quot;Time to display a list of operating systems&quot; checkbox, or select the &quot;Time to display recovery option when needed&quot; checkbox and change the number of seconds to delay for it.</td>
<td><img src="image" alt="Startup and Recovery" /> You must be logged in as an administrator to change these settings. See “User Accounts” on page 69 for more information.</td>
</tr>
</tbody>
</table>

*NOTE* You must be logged in as an administrator to change these settings. See “User Accounts” on page 69 for more information.
7 Using Microsoft Windows Operating System

NOTE The capabilities described in this section are Microsoft Windows features. The following information provides some guidelines for using the capabilities with the test set, but you need to refer to the Windows help documentation for more information. Your version of Windows may not match these instructions exactly. Also, you need an external keyboard and mouse to fully use these features.

The following topics can be found in this section:

“Windows Shortcuts” on page 100
“Remote Desktop: Using the Test Set Remotely” on page 101
“Windows Taskbar Auto-Hide Feature” on page 108
Windows Shortcuts

The following keyboard shortcuts can be used to perform windows tasks.

<table>
<thead>
<tr>
<th>To do the following:</th>
<th>Press these keys:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the Windows Start Menu</td>
<td>Ctrl+Esc</td>
</tr>
<tr>
<td>Cycle through all open applications</td>
<td>Alt+Tab</td>
</tr>
<tr>
<td>Select the first menu of a menu bar</td>
<td>Alt</td>
</tr>
<tr>
<td>Move through menu headings</td>
<td>Left Arrow, Right Arrow</td>
</tr>
<tr>
<td>Open (drop down) a menu</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Move through items in an expanded menu</td>
<td>Up Arrow, Down Arrow</td>
</tr>
<tr>
<td>Close the current menu selection</td>
<td>Esc</td>
</tr>
<tr>
<td>Cancel the current menu bar selection</td>
<td>Alt</td>
</tr>
<tr>
<td>Open an application's control menu (usually the left-most menu on the menu bar, starting with File).</td>
<td>Alt+Select</td>
</tr>
<tr>
<td>In a dialog: move between tabs</td>
<td>Ctrl+Tab</td>
</tr>
<tr>
<td>In a dialog: move forward through dialog box items</td>
<td>Tab</td>
</tr>
<tr>
<td>In a dialog: move backward through dialog box items</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>In a dialog: open a list box</td>
<td>Alt+Down Arrow</td>
</tr>
<tr>
<td>In a dialog list box or check box: select or deselect items</td>
<td>Select</td>
</tr>
<tr>
<td>In a dialog list box or check box: select or deselect one item at a time</td>
<td>Shift-Up Arrow, Shift-Down Arrow</td>
</tr>
<tr>
<td>In My Computer, expand a selected folder</td>
<td>Enter</td>
</tr>
<tr>
<td>In My Computer, open a folder one level up from the current folder</td>
<td>Bk Sp</td>
</tr>
</tbody>
</table>
Remote Desktop: Using the Test Set Remotely

Windows Remote Desktop can be used for remote control of the test set.

The Remote Desktop functionality is a Microsoft Windows capability. The following discussion provides some guidelines for using this capability with the test set. You need to refer to the Windows help documentation for more information. As Windows evolves, these instructions may no longer be exact.

Overview of remote desktop operation

Using the Remote Desktop functionality of the test set allows you to control and interact with the test set from a remote computer, as though you were sitting in front of the test set.

When you have configured the test set for remote connectivity, and configured a separate computer to act as a Remote Desktop Host, you can send commands to the test set from the remote computer, and you can see the test set display on the screen of the remote computer.

This section provides full details of how to set up the test set for remote connectivity, and also how to set up a computer running any 32-bit version of Microsoft Windows as a Remote Desktop Host.

Setting up the test set

Before the test set can be controlled through a Remote Desktop Connection, it must be set up to allow connection from a remote computer.

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. To perform this operation successfully, you must have Administrator level access to the test set.</td>
<td>The default Administrator password is: Keysight4u!</td>
</tr>
<tr>
<td>2. On the test set, open the Windows Control Panel (select Control Panel on the Start menu).</td>
<td>A System Properties window appears, with the Remote tab displayed.</td>
</tr>
<tr>
<td>5. Check the box labeled Allow Remote Assistance connections to this computer, if it is not already checked.</td>
<td></td>
</tr>
</tbody>
</table>
Setting up the remote computer

The procedure depends on whether the Remote Computer to be set up is running Windows XP, Windows 7, or another version of Microsoft Windows.

If the remote computer is running Windows XP or Windows 7, no additional setup is required, as these versions of Windows include the Remote Desktop Connectivity Client software.

If the remote computer running another version of Windows, you can use any 32-bit version of Windows (Windows 95, 98, ME, NT4, or 2000) to install and run the Client software for Remote Desktop Connectivity. However, you need to have available a Windows XP or Windows 7 installation CD-ROM, because that contains the Client software.

NOTE The following instructions relate to software provided by Microsoft Corporation. Keysight offers no warranty regarding the operation of such software. The procedure described here may be changed by Microsoft at some future time.
Using Microsoft Windows Operating System
Remote Desktop: Using the Test Set Remotely

The Client software can be installed as follows:

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. When the Welcome Screen appears, click Perform additional tasks</td>
<td></td>
</tr>
<tr>
<td>2. From the <strong>What do you want to do?</strong> screen, click <strong>Set up Remote Desktop Connection.</strong></td>
<td>The Remote Desktop Connection InstallShield Wizard appears.</td>
</tr>
<tr>
<td>3. Click Next.</td>
<td>Follow the on screen instructions provided by the Wizard.</td>
</tr>
<tr>
<td>4. To access the installed software, click <strong>Start &gt; All Programs &gt; Accessories &gt; Communications &gt; Remote Desktop Connection.</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Finding the computer name of the test set**

To connect a remote computer to the test set, you need to know the test set’s Computer Name. On the E7760B Application, select **System > System Information.** A window opens which lists the **Computer Name** and other information about the test set.

**Initializing a remote desktop session**

The procedure is as follows:

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click <strong>Start &gt; All Programs &gt; Accessories &gt; Remote Desktop Connection.</strong></td>
<td>A Remote Desktop Connection dialog appears:</td>
</tr>
</tbody>
</table>

![Remote Desktop Connection dialog](image)
Using Microsoft Windows Operating System  
Remote Desktop: Using the Test Set Remotely

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Enter the computer name or IP address of the test set.</td>
<td>A login dialog box appears.</td>
</tr>
<tr>
<td>3. Click Connect.</td>
<td>The default account name is Instrument and the default password is measure4u, but these parameters may be changed by instrument users.</td>
</tr>
<tr>
<td>4. Enter the login account name and password.</td>
<td>Only the current User or an Administrator can remotely log into the test set. To see who the current user of the test set is, press Ctrl+Esc on the test set until you can view the current user name on the Start menu. If no one is currently logged into the test set, any valid instrument user can remotely log in.</td>
</tr>
</tbody>
</table>

Setting Remote Desktop Options

The procedure is as follows:

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. On the Remote Desktop Connection window, click Options. The window expands vertically to show several configuration tabs.</td>
<td>The Options dialog has several tabs. Generally, the default settings are correct.</td>
</tr>
<tr>
<td>2. Under the General tab, ensure that the Computer name, User name and Domain name are set correctly.</td>
<td>You may choose to enter the password and save it for future sessions, by checking the Save my password box.</td>
</tr>
</tbody>
</table>
3. Click the Display tab. Under Display configuration, you may select the size of the window in which the test set display appears. Under Colors, you may select the color depth of the display. Recommendations: do not select a size smaller than 1024 X 768, or a color depth of less than 15 bits.

4. Click the Local Resources tab. Click the More button to see a selection of local resources; selecting the Drives checkbox enables you to transfer data between the remote desktop and the local PC. To transfer data, click Start on the task bar of the remote computer, then click My Computer. Explorer opens on the remote computer and displays the drives of both the remote computer and the local computer. You can now copy and paste between the two disk drives.
<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.</td>
<td>Click the <strong>Experience</strong> tab. To Optimize the performance of the Remote Desktop session, choose the appropriate connection format from the drop-down list.</td>
</tr>
</tbody>
</table>

![Remote Desktop Connection](image.png)
## Ending a Remote Desktop session

There are two ways to disconnect the remote computer from the test set to end the session:

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click the X, then click OK.</td>
<td>For full-screen, the X appears at the top center of the window. For non full-screen, the X appears in a red box at the right of the window’s title bar.</td>
</tr>
<tr>
<td>Or...</td>
<td></td>
</tr>
<tr>
<td>2. When the remote desktop is full screen, move the cursor to the bottom left of the window. Click Start, Disconnect.</td>
<td>(You will be asked to confirm that you want to disconnect.)</td>
</tr>
<tr>
<td>3. Click Disconnect to confirm.</td>
<td></td>
</tr>
</tbody>
</table>
Windows Taskbar Auto-Hide Feature

The Windows taskbar should always be in the auto-hide mode when using the test set application. If the taskbar is not set to auto-hide, the lower part of the test set display is obscured by the taskbar.

If a mouse is attached to the test set, and you move the mouse cursor to the bottom of the display (either deliberately or accidentally), the taskbar automatically appears. Provided that the taskbar is in auto-hide mode, you can make it disappear again by moving the mouse cursor away from the bottom of the screen.

If at any time the Windows taskbar is inadvertently set to the non-auto-hide mode, you can restore the auto-hide behavior by doing the following:

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. <strong>Click Start &gt; Control Panel</strong></td>
<td>(Or press Ctrl + Esc.)</td>
</tr>
<tr>
<td>2. <strong>In Classic View, click Taskbar and Start Menu.</strong></td>
<td>(Or, in Category View, click Appearance and Themes, Taskbar and Start Menu.)</td>
</tr>
<tr>
<td>3. <strong>Click the Taskbar tab.</strong></td>
<td>The Taskbar and Start Menu Properties dialog appears:</td>
</tr>
<tr>
<td>4. <strong>Check the Auto-hide the taskbar checkbox and click OK.</strong></td>
<td></td>
</tr>
</tbody>
</table>
8 Troubleshooting

The following topics can be found in this section:

“Identifying Problems” on page 110
“Returning Your Test Set for Service” on page 112
Troubleshooting
Where to get technical help

Where to get technical help

For online assistance: http://www.keysight.com/find/assist
To contact Keysight Technologies: http://www.keysight.com/find/contactus
Also, see “Locations for Keysight Technologies” on page 113.

Identifying Problems

No operator serviceable parts inside. Refer servicing to qualified personnel. To prevent electrical shock do not remove covers.

1. If the E7760B appears to be in a faulty state, reboot the instrument (restart the Windows operating system).

2. A source of valuable information is the Event Viewer, which can be opened from the Windows Start menu (enter the name Event Viewer in the search field to locate this utility).

The Event Viewer window makes it possible to find information on recent administrative events such as errors and warnings. Look under Applications and Service Logs > SA, as illustrated in Figure 8-1 on page 111).
Troubleshooting
Identifying Problems

Figure 8-1  Event Viewer window
Returning Your Test Set for Service

Calling Keysight Technologies

Keysight Technologies has offices around the world to provide you with complete support for your wireless test set. To obtain servicing information, or to order replacement parts, contact the nearest Keysight Technologies office listed under “Locations for Keysight Technologies” on page 113. In any correspondence or telephone conversations, refer to your test set by its product number, full serial number, and software revision.

To access your product information, select System Information on the System menu (this relates mainly to installed software and licenses) and Hardware Information on the System menu (this relates mainly to installed circuit boards).
Locations for Keysight Technologies

For online assistance: [http://www.keysight.com/find/assist](http://www.keysight.com/find/assist)

To contact Keysight Technologies: [http://www.keysight.com/find/contactus](http://www.keysight.com/find/contactus)

Alternately, contact the nearest Keysight sales office:

### Americas

<table>
<thead>
<tr>
<th>Country</th>
<th>Phone</th>
<th>Country</th>
<th>Phone</th>
<th>Country</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canada</td>
<td>(877) 894 4414</td>
<td>Brazil</td>
<td>55 11 3351 7010</td>
<td>Mexico</td>
<td>001 800 254 2440</td>
</tr>
<tr>
<td>United States</td>
<td>(800) 829 4444</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Asia & Pacific

<table>
<thead>
<tr>
<th>Country</th>
<th>Phone</th>
<th>Country</th>
<th>Phone</th>
<th>Country</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>1 800 629 485</td>
<td>China</td>
<td>800 810 0189</td>
<td>Hong Kong</td>
<td>800 938 693</td>
</tr>
<tr>
<td>India</td>
<td>1 800 112 929</td>
<td>Japan</td>
<td>0120 (421) 345</td>
<td>Korea</td>
<td>080 769 0800</td>
</tr>
<tr>
<td>Malaysia</td>
<td>1 800 888 848</td>
<td>Singapore</td>
<td>1 800 375 8100</td>
<td>Taiwan</td>
<td>0800 047 866</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Other Asia-Pacific countries:</td>
<td>(65) 6375 8100</td>
</tr>
</tbody>
</table>

### Europe & Middle East

<table>
<thead>
<tr>
<th>Country</th>
<th>Phone</th>
<th>Country</th>
<th>Phone</th>
<th>Country</th>
<th>Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austria</td>
<td>0800 001122</td>
<td>Belgium</td>
<td>0800 58580</td>
<td>Finland</td>
<td>0800 523252</td>
</tr>
<tr>
<td>France</td>
<td>0805 980333</td>
<td>Germany</td>
<td>0800 6270999</td>
<td>Ireland</td>
<td>1800 832700</td>
</tr>
<tr>
<td>Israel</td>
<td>1 809 343051</td>
<td>Italy</td>
<td>800 599100</td>
<td>Luxembourg</td>
<td>+32 800 58580</td>
</tr>
<tr>
<td>Netherlands</td>
<td>0800 0233200</td>
<td>Russia</td>
<td>8800 5009286</td>
<td>Spain</td>
<td>0800 000154</td>
</tr>
<tr>
<td>Sweden</td>
<td>0200 882255</td>
<td>Switzerland</td>
<td>0800 805353</td>
<td>United Kingdom</td>
<td>0800 0260637</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Opt. 1 (DE), Opt. 2 (FR), Opt. 3 (IT)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>